SynOptics 28xxx Management Module

Supports Management Module SM-SYN1006
Notice

Aprisma Management Technologies, Inc. (Aprisma), reserves the right to make changes in specifications and other information contained in this document without prior notice. The reader should in all cases consult Aprisma to determine whether any such changes have been made.

The hardware, firmware, or software described in this manual is subject to change without notice.

IN NO EVENT SHALL APRISMA, ITS EMPLOYEES, OFFICERS, DIRECTORS, AGENTS, OR AFFILIATES BE LIABLE FOR ANY INCIDENTAL, INDIRECT, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING BUT NOT LIMITED TO LOST PROFITS) ARISING OUT OF OR RELATED TO THIS MANUAL OR THE INFORMATION CONTAINED IN IT, EVEN IF APRISMA HAS BEEN ADVISED OF, KNOWN, OR SHOULD HAVE KNOWN, THE POSSIBILITY OF SUCH DAMAGES.

Copyright © October 2000 by Aprisma Management Technologies. All rights reserved.

Printed in the United States of America.

Order Number: 9032252-01

Aprisma Management Technologies, Inc.
121 Technology Drive
Durham NH 03824

SPECTRUM, the SPECTRUM IMT/VNM logo, DCM, IMT, and VNM are registered trademarks, and SpectroGRAPH, SpectroSERVER, Inductive Modeling Technology, Device Communications Manager, and Virtual Network Machine are trademarks of Aprisma or its affiliates.

Ethernet is a trademark of Xerox Corporation.

Virus Disclaimer

Aprisma makes no representations or warranties to the effect that the Licensed Software is virus-free.

Aprisma has tested its software with current virus checking technologies. However, because no anti-virus system is 100% reliable, we strongly caution you to write protect and then verify that the Licensed Software, prior to installing it, is virus-free with an anti-virus system in which you have confidence.

Restricted Rights Notice

(Applicable to licenses to the United States Government only.)

1. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013.

Aprisma Management Technologies, Inc., 121 Technology Drive NH 03824

2. (a) This computer software is submitted with restricted rights. It may not be used, reproduced, or disclosed by the Government except as provided in paragraph (b) of this Notice or as otherwise expressly stated in the contract.

(b) This computer software may be:

(1) Used or copied for use in or with the computer or computers for which it was acquired, including use at any Government installation to which such computer or computers may be transferred;

(2) Used or copied for use in a backup computer if any computer for which it was acquired is inoperative;

(3) Reproduced for archival or backup purposes;

(4) Modified, adapted, or combined with other computer software, provided that the modified, combined, or adapted portions of the derivative software incorporating restricted computer software are made subject to the same restricted rights;

(5) Disclosed to and reproduced for use by support service contractors in accordance with subparagraphs (b) (1) through (4) of this clause, provided the Government makes such disclosure or reproduction subject to these restricted rights; and

(6) Used or copied for use in or transferred to a replacement computer.

(c) Notwithstanding the foregoing, if this computer software is published copyrighted computer software, it is licensed to the Government, without disclosure prohibitions, with the minimum rights set forth in paragraph (b) of this clause.

(d) Any other rights or limitations regarding the use, duplication, or disclosure of this computer software are to be expressly stated in, or incorporated in, the contract.

(e) This Notice shall be marked on any reproduction of this computer software, in whole or in part.
Contents

INTRODUCTION .................................................. 5
   Purpose and Scope ........................................ 5
   Required Reading ........................................... 5
   Supported Devices ........................................... 6
   The SPECTRUM Model ..................................... 6
   Accessing SPECTRUM Views from the Device Icon .... 6

DEVICE VIEW .................................................. 8
   Logical Device View ........................................ 8
   Logical Module Icon ........................................ 9
   Icon Subviews for the Logical Module ................. 10
   Icon Subviews for Ports .................................. 11
   Switch Community View .................................. 11
   Port Statistics ............................................ 12
   Network-to-Internal Stats ............................... 12
   Network Received ......................................... 12
   Internal Transmit ........................................... 12
   Internal-to-Network Stats ............................... 13
   Internal Received .......................................... 13
   Enable/Disable Port ....................................... 13
   Physical Device View .................................... 14

CONFIGURATION VIEWS .................................. 15
   Port Configurations Table ............................... 15
   Chassis Configuration View ............................. 21
   Agent Configuration View ............................... 23

APPLICATION VIEWS ........................................... 26
   Application Icons ......................................... 27
   Supported Applications .................................. 27
   SynOptics 28xxx Common Application .................. 28
   Agent Information View ................................... 28
   Agent Configuration View ............................... 28
   Trap Receiver View ....................................... 28
   Trap Receiver Table ....................................... 28
   Add Trap Receiver View ................................... 29
   Switch Community View .................................. 30
   Domain .................................................... 30
   Domain Table ............................................. 30
   Domain Port Table ....................................... 32
   Domain Creation View .................................... 33
   Port Domain Table ....................................... 33
   Standard Table Buttons ................................ 34
   Trunk Information View .................................. 34
   Trunk Information Table ................................. 35
   Switch List View ......................................... 35
   Switch List Table ......................................... 35
   History Logs ............................................... 36
   Reset History ............................................. 36
   Error History ............................................. 36
   Error Log Table .......................................... 37

Off-Page Reference Panel .................................... 24
Introduction

This section introduces the SPECTRUM Device Management documentation for SynOptics 28xxx Series devices.

This introduction to the SynOptics 28xxx documentation contains the following information:

- **Purpose and Scope**
- **Required Reading**
- **The SPECTRUM Model** (Page 6)
- **Supported Devices** (Page 6)

**Purpose and Scope**

Use this documentation as a guide for managing SynOptics devices with the SPECTRUM management module SM-SYN1006. The documentation describes the icons, menus, and views that enable you to remotely monitor, configure, and troubleshoot SynOptics devices through software models in your SPECTRUM database.

Only information specific to the supported management module is included under this topic. For general information about device management using SPECTRUM and for explanation of basic SPECTRUM functionality, and navigation techniques, refer to the documentation listed under Required Reading.

**Required Reading**

To use this documentation effectively, you must be familiar with the information covered by the other SPECTRUM online documentation topics listed below.

- **Getting Started with SPECTRUM for Operators**
- **Getting Started with SPECTRUM for Administrators**
- **How to Manage Your Network with SPECTRUM**
- **SPECTRUM Views**
- **SPECTRUM Menus**
- **SPECTRUM Icons**
Supported Devices

The model type name refers to the models used to specify attributes, actions, and associations for the device in SPECTRUM. The model type names for SynOptics 28xxx series switches are SwSyn28xxx and SwSyn281xx

SynOptics 28xxx Switches are managed through the Simple Network Management Protocol (SNMP) Advanced Agent. Table 1 provides a list of SPECTRUM-supported models and their descriptions. 282xx devices will be supported in a later revision of SPECTRUM.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>28115</td>
<td>Managed 10BASE-T Work Group Concentrator. 16 STP with AUI Interconnection Port. (Fast Ethernet)</td>
</tr>
<tr>
<td>28104</td>
<td>Managed 10BASE-T Work Group Concentrator. 16 STP with FOIRL Interconnection Port. (Fast Ethernet)</td>
</tr>
</tbody>
</table>

The SPECTRUM Model

SPECTRUM uses a single device model type, SwSyn28xxx, for modeling any of the supported SynOptics 28xxx devices. SwSyn28xxx models are represented in SpectroGRAPH views by device icons.

Accessing SPECTRUM Views from the Device Icon

The Device icon provides access to SPECTRUM views, which display device-specific information. Access SPECTRUM views using double-click zones and Icon Subviews menus (Figure 1).

To access the Icon Subviews menu as shown in Figure 1, do the following:

1. Highlight the icon.
2. From the View menu, select Icon Subviews or click the applicable mouse button (middle or right).
**Figure 1:** Using the Icon Subviews Menu to Access SPECTRUM Views
Device View

This section describes the various Device views available for models of SynOptics 28xxx devices in SPECTRUM.

Device views use icons and labels to represent the modeled device and its components such as modules, ports, and applications. There are three types of device views for SynOptics 28000 series switch models:

- **Logical Device View**
- **Switch Community View** (Page 11)
- **Physical Device View** (Page 14)

SPECTRUM provides both static physical and dynamic logical representations of the switch configuration. With the dynamic logical representation, if the configuration changes, you see the corresponding change within the view after the model’s next polling cycle.

Logical Device View

This view displays a logical representation of the switch module that provides information about the switch instead of presenting a physical image.

As Figure 2 shows, the Logical Module icon representing the switch contains labels that apply to the switch itself, as well as icons representing its individual ports.

![Logical Module icon](image)

Figure 2: Logical Module icon
Logical Module Icon

Figure 3 shows a detailed illustration of the Logical Module icon and the double-click zones and subviews available from it. The following sections describe each area of the module.

The Logical Module icon provides the following module-specific information:

**Module Number**
Identifies the number of the module in the hub and provides a double-click zone to access Module Notes.

**Module Model Number**
Identifies which module type this icon represents.

**Module Status**
Displays the status of the Module: Master or Normal.

The Logical Module icon provides the following information for each of the module’s ports:

**Port Identifier**
Identifies which port this icon represents and provides a double-click zone to access Port Notes.

**Port Status**
Displays the status of the port and provides a double-click zone that opens the Port
Device View

Performance View. Table 2 describes and lists port status conditions.

**Table 2: Port Status Conditions**

<table>
<thead>
<tr>
<th>Status</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>NLNK (No Link)</td>
<td>Yellow</td>
</tr>
<tr>
<td>LINK</td>
<td>Green</td>
</tr>
<tr>
<td>PART-Blue</td>
<td>Partitioned, in Link</td>
</tr>
<tr>
<td>PART-Yellow</td>
<td>Partitioned, No Link</td>
</tr>
<tr>
<td>PART-Red</td>
<td>Partitioned with a Link</td>
</tr>
<tr>
<td>?</td>
<td>Blue</td>
</tr>
</tbody>
</table>

**Port Type**
Displays the type of port: Duplex or Half Duplex.

**Port Speed**
Displays the speed of the port: 200M, 100M or 10M.

Icon Subviews for the Logical Module

Table 3 describes each of the device-specific Module Icon Subviews menu selections available for this device.

**Table 3: Module Icon Subviews Menu**

<table>
<thead>
<tr>
<th>Menu Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module Notes</td>
<td>Opens the Module Notes view.</td>
</tr>
<tr>
<td>Chassis Configuration</td>
<td>Opens the Chassis Configuration view, discussed in the Configuration Views (Page 15).</td>
</tr>
<tr>
<td>Port Configurations Table</td>
<td>Opens the Port Configurations Table (Page 15).</td>
</tr>
<tr>
<td>Agent Information</td>
<td>Opens the Agent Information view, discussed in the Agent Information View (Page 28).</td>
</tr>
<tr>
<td>Switch Community</td>
<td>Opens the Switch Community View (Page 11).</td>
</tr>
<tr>
<td>History Logs</td>
<td>Opens the History Logs (Page 36).</td>
</tr>
</tbody>
</table>
Device View

Icon Subviews for Ports

Table 4 describes each of the device-specific Port Icon Subviews menu selections available for this device.

<table>
<thead>
<tr>
<th>Menu Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance</td>
<td>Opens the Port Performance view.</td>
</tr>
<tr>
<td>Port Notes</td>
<td>Opens the Port Notes view.</td>
</tr>
<tr>
<td>Port Configurations</td>
<td>Opens the Port Configurations view, discussed in Port Configurations Table</td>
</tr>
<tr>
<td>Port Statistics</td>
<td>This selection contains a submenu from which you may access the Port Network-to-Internal Statistics view or the Port Internal-to-Network Statistics view, both of which are described below.</td>
</tr>
<tr>
<td>Port to MAC</td>
<td>Opens the Port to MAC view, discussed in Application Views</td>
</tr>
<tr>
<td>Enable/Disable Port</td>
<td>Opens the Enable/Disable Port view, described below.</td>
</tr>
</tbody>
</table>

Switch Community View

Figure 4 shows an example of the Switch Community view.

This view displays the connections between domains and ports within a switch community. All the switches connected together are called a “community.” At the top of this view is a board that represents the Switch Community with “ports” that represent the domains (or VLANs). Below this are the Logical Module icons representing each of the switches in the community that are modeled in SPECTRUM. The Master is the first switch. If the Master is not modeled, then this view will only show the
**Device View**

domains that the switch is in and the Logical Module icon for the switch from which the view was accessed. The view will update if a switch or VLAN is added or removed from the community.

Clicking a port number highlights the domain number of the domain icon containing that port. Clicking the domain number on a domain icon highlights the port number of all the ports in the domain. Clicking the domain number again deselects all the ports and the domain icon.

In addition to the capabilities described above, the port and module icons provide the same information described under *Logical Module Icon*.

**Port Statistics**
Contains a submenu from which the Network-to-Internal Stats and Internal-to-Network Stats views may be accessed.

---

**Network-to-Internal Stats**
The SynOptics 28xxx Port Network-to-Internal Statistics View. This view contains the following information:

**Network Received**
This panel contains the following fields:

**Good Frames**
The number (32 bit) of good frames received from the network.

**Align Errors**
The number (32 bit) of received frames with an alignment error from the network.

**Crc Errors**
The number (32 bit) of received frames with a CRC error from the network.

**Overruns**
The number (32 bit) of times that a receiver overrun condition was detected when receiving frames from the network.

**Internal Transmit**
This panel contains the following fields:

**Frames**
The number (32 bit) of transmitted frames to the internal channel.

---

**Note:**
The trunk port is not part of the domain: it connects the switches within the LAN. Trunk port icons look the same as port icons in the Switch Community View, except a trunk port icon has a violet background behind its number.
**Device View**

**Buffer Overflows**
Displays the number (32 bit) of buffer overflows occurring while transmitting a frame to the internal channel.

**Internal-to-Network Stats**
Opens the SynOptics 28xxx Port Internal-to-Network Statistics View. This view contains the following information:

**Internal Received**
This panel contains the following fields:

**Frames**
The number (32 bit) of transmitted frames from the internal channel out the port.

**Buffer Overflows**
The number (32 bit) of buffer overflows occurring while transmitting a frame from the internal channel out the port.

**Network Transmit**
This panel contains the following field:

**Congestion**
The number (32 bit) of times that a congestion was detected when transmitting to the network. The meaning of “congestion” varies between the two types of ports.

**Enable/Disable Port**
This panel lets you enable or disable a particular port. The port state is displayed along with the following fields and buttons:

**Module**
The number specifying the hub location of the module containing the port.

**Port**
The number uniquely identifying the selected port on the module.

**Port State**
This menu button allows you to **Enable** or **Disable** the port.

![Apply](image)
Applies the current settings.

![Read](image)
Reads and updates the information from the device.

![Cancel](image)
Use this button to exit the view. Unapplied settings will revert to last applied settings.
**Physical Device View**

*Access:* From the *Icon Subviews* menu of the Device Icon, select *Physical.*

This view (Figure 5) shows a static physical representation of the switch, including each of its modules and ports.

The Physical Device view allows you to access the same Icon Subviews menu that is available from the module icon in the Logical Device view. To access the Icon Subviews, select *Icon Subviews* from the View menu. Port views cannot be accessed from this view.

---

**Figure 5:**  *SynOptics 28xxx Switch Device View Physical Module*
This section describes the Configuration views available for SynOptics 28xxx series switches in SPECTRUM.

Configuration views allow you to view and modify current settings for the modeled device and its interfaces, ports, and applications. The following Configuration views are available for models of SynOptics 28xxx devices:

- **Port Configurations Table**
- **Chassis Configuration View** (Page 21)
- **Agent Configuration View** (Page 23)

Figure 6 is an example of a Configuration View.

**Port Configurations Table**

*Access: From the Icon Subviews menu of the Logical Module Icon, select Port Configurations.*
Configuration Views

The Port Configurations Table specifies the configuration of each port for a switch. This table contains the following fields and button:

Slot
The slot number on the switch identifying the port.

Port
The port number on the switch.

Domain Id
The unique ID of the domain.

Partition Status
The partition status of the port. Possible values are enabled (enables the port), partition (partitions the port), other (partition status unknown). The value partition will survive resets of the host card, causing the port to be partitioned indefinitely until the value enabled is written. Partitioning a trunk port is not allowed.

Link Status
The link status of the port. The values are other (other or not known) off (link is not connected) (link is connected). Ports will have a value of off or on. All other port types will have a value of other.

Connector
The type of connector that the port offers. Table 5 lists and describes the possible types.

**Table 5: Connector Types**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>other</td>
<td>other or not known</td>
</tr>
<tr>
<td>rj45</td>
<td>RJ45 connector</td>
</tr>
<tr>
<td>fiber</td>
<td>Fiber connector</td>
</tr>
<tr>
<td>expansionPort</td>
<td>Expansion Port connector</td>
</tr>
</tbody>
</table>

Media Type
The media type for the port. Table 6 lists and describes the possible types.

**Table 6: Media Types**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>other</td>
<td>other or not known</td>
</tr>
<tr>
<td>m10BaseT</td>
<td>10BaseT Ethernet</td>
</tr>
<tr>
<td>m100M</td>
<td>100M Ethernet</td>
</tr>
<tr>
<td>m10or100M</td>
<td>10BaseT and 100M switchable</td>
</tr>
<tr>
<td>m200e</td>
<td>200M expansion port</td>
</tr>
</tbody>
</table>
Link Type
The type of link for the port. Table 7 lists and describes the possible types.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>otherIntCon</td>
<td>The port is connected to an interconnection device which is NOT a SynOptics interconnect device.</td>
</tr>
<tr>
<td>synIntCon</td>
<td>The port is connected to a SynOptics interconnection device.</td>
</tr>
<tr>
<td>feeder</td>
<td>The port is being used for host connectivity.</td>
</tr>
<tr>
<td>trunk</td>
<td>The port is being used for interconnecting LAN Switches in a community.</td>
</tr>
</tbody>
</table>

Speed
The speed for a port. Table 8 lists the possible speeds.

<table>
<thead>
<tr>
<th>Value</th>
<th>Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>s10</td>
<td>10Mbits per second</td>
</tr>
<tr>
<td>s100</td>
<td>100Mbits per second</td>
</tr>
<tr>
<td>s200</td>
<td>200Mbits per second</td>
</tr>
</tbody>
</table>

The port media type (expansion or regular) and port link type (trunk or feeder) determine the valid values, and whether you can change the speed: you cannot change the speed for trunk ports.

The speed for expansion ports can be set to s100 or s200. However, the value of this parameter may be automatically set whenever the expansion port is connected to another switch.

Port Configurations
Highlight a row in the Port Configurations Table and click this button to access the SynOptics 28xxx Port Configurations View. This view is also accessible from the Icon Subviews menu for the
Configuration Views

Port icon. This view contains the following information:

**Slot**
The slot number on the switch identifying the port.

**Port**
The port number on the switch.

**Domain ID**
The unique ID of the domain.

**Remote Fault**
The remote fault sensing of fiber ports. Possible values are `other` (other or not known), `fault` (remote device signalled a fault condition) or `nofault` (remote device signalled a no fault condition).

Only fiber ports will have a value of `fault` or `nofault`. All other port types will have a value of `other`.

Connecting Device
Identifies the type of device to which the port is connected. Table 9 lists and describes the possible devices.

**Table 9: Connecting Devices**

<table>
<thead>
<tr>
<th>Device</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>other</td>
<td>other or not known</td>
</tr>
<tr>
<td>model514</td>
<td>Model 514 fiber transceiver</td>
</tr>
<tr>
<td>model515</td>
<td>Model 515 UTP transceiver</td>
</tr>
<tr>
<td>cascade</td>
<td>Model 28K LattisSwitch</td>
</tr>
<tr>
<td></td>
<td>Ethernet Switch</td>
</tr>
</tbody>
</table>

For expansion ports, `other` means that there is no device connected. For all other ports, the value `other` is returned for device types other than those listed above.

**Operational Type**
Indicates the operational switch port type. The operational port type is the outcome of LattisSpan
protocol and is determined by the system. Table 10 lists and describes the possible types.

**Table 10: Operational Types**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>other</td>
<td>other or not known</td>
</tr>
<tr>
<td>skip</td>
<td>Skip this enumeration intentionally for providing compatibility between different versions of LattisSpan.</td>
</tr>
<tr>
<td>actfeeder.active feeder</td>
<td>The port is being used for host connectivity.</td>
</tr>
<tr>
<td>trunk</td>
<td>The port is being used for interconnecting LAN Switches in a community.</td>
</tr>
<tr>
<td>stbfeeder.standby feeder</td>
<td>The port is being used as standby port for host connectivity.</td>
</tr>
</tbody>
</table>

**Flow Control**
The flow control status of the port. It is in effect only when the port is operating at 100 mbs in full-duplex mode. Possible values are enabled (enable flow control of the port), disabled (disable flow control of the port), other (status unknown).

**Port Type Configuration**
Indicates the current switch port type configuration. Possible values are other (other or not known), auto (the port is configured for interconnecting LAN Switches in a community), or feeder (the port is configured for host connectivity).

**Next Boot Type**
Indicates the switch port type that will be in effect after the next boot of the switch. Table 11 lists and describes the possible types.

**Table 11: Next Boot Types**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>other</td>
<td>other or not known</td>
</tr>
<tr>
<td>auto</td>
<td>The port is configured for interconnecting switches in a community.</td>
</tr>
<tr>
<td>feeder</td>
<td>The port is configured for host connectivity.</td>
</tr>
</tbody>
</table>

**Partition Status**
The partition status of the port. Possible values are “enabled” (enable the port), “partition” (partition the port), or “other” (partition status unknown). The value “partition” will survive resets of the host card, causing the port to be partitioned indefinitely until the value enabled is written. Partitioning a trunk port is not allowed.
**Configuration Views**

**Link Status**
The link status of the port. Possible values are **other** (other or not known), **off** (link is not connected) or **on** (link is connected).

Ports will have a value of **off** or **on**. All other port types will have a value of “other.”

**Connector Type**
The type of connector that the port offers. See Table 5 (Page 16) for a list and description of Connector Types.

**Duplex Mode**
The port can be set to operate in either half or full duplex mode. The values are **halfDuplex** or **fullDuplex**.

The port media type (expansion or regular) and port link type (trunk or feeder) determine your ability to choose between half or full duplex mode. The port cannot set to half duplex mode if the port speed is set to s200. However, the value of this parameter may be automatically set whenever the expansion port is connected to another switch.

**Media Type**
The media type for the port. See Table 6 (Page 16) for a list and description of Media Types.

**Port Speed**
The speed of the port. See Table 8 (Page 17) for a list of the possible speeds.

The port media type (expansion or regular) and port link type (trunk or feeder) determine the valid values, and whether you can change the speed. You cannot change the speed for trunk ports.

For expansion ports, the s100 and s200 can be set. However, the value of this parameter may be automatically set whenever the expansion port is connected to another switch.

**Link Type**
The type of link for the port. See Table 7 (Page 17) for a list and descriptions of the possible types.

**Configuration Changes**
The total number of port configuration changes to this switch including port partition/unpartition, port speed change, port reset and port half/full duplex change, since warm/cold restart.

**Last Change**
The value of sysUpTime when the last port configuration change to the switch was detected. (If none have been detected since warm/cold restart, then the value is zero).
Port Reset
Action object to reset a port. Possible values are “reset” and “resetOK.”

Chassis Configuration View

Access: From the Icon Subviews menu for the Logical Module icon, select Chassis Configuration.
This view contains the following information:

Chassis Switch ID
The unique identifier for the switch.

Chassis Type
The chassis type.

Chassis Description
A description of the chassis.

Chassis Location
Indicates the physical location of the chassis (e.g., “fourth floor wiring closet in building A”).

Chassis Contact
Identifies the contact person for the chassis.

Chassis Version
The major revision designation of the chassis, if available.

Chassis Serial Number
The serial number of the chassis, if available.

Total Configuration Changes
Indicates the total number of configuration changes (other than physical additions or removals) across all boards in the chassis that have been detected since cold/warm start of the agent.

Last Configuration Changes
The time when the last configuration change (other than physical additions or removals) on any board in the chassis was detected. If none have been detected since cold/warm start of the agent, then the value is zero.

System Date
The system date in mm/dd/yy format.

System Time
The system time in hh:mm:ss format.

Number of Fans
Indicates the total number of fans in the chassis.
**Feature Mode**
Displays the type of switch. Table 12 lists and describes the possible modes.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>other</td>
<td>other or not known</td>
</tr>
<tr>
<td>original</td>
<td>Legacy 28115 or 28104 type of original</td>
</tr>
<tr>
<td>standard</td>
<td>standard 28115</td>
</tr>
<tr>
<td>advanced</td>
<td>advanced switches (28115/A20 or 28104/A20)</td>
</tr>
<tr>
<td>upgrade</td>
<td>upgrade advanced 28115/Adv</td>
</tr>
</tbody>
</table>

**Topology Mode**
Identifies the method used for detection of redundant links to switches. Possible values are other (other or not known), lattisspan (SynOptics way), and a8021d (8021: IDMode).

**Board Information**
This button opens the Board Information view, which provides the following information for each board inserted in the chassis. Initially, this table will describe the single board used by the switch for all functionality including SNMP management.

**Board**
The board number.

**Status Display**
Indicates the current ASCII character display of the board, for boards with display hardware. Values are concatenated for boards with multiple displays.

**Date Code**
The date of manufacture of the board, if available, in YYYYmmdd format.

**Config Source**
Indicates the source of the configuration at the last board reset. Table 13 lists and describes the possible sources.

<table>
<thead>
<tr>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>other</td>
<td>unknown or some other value</td>
</tr>
<tr>
<td>nms</td>
<td>from the network management station</td>
</tr>
<tr>
<td>nvram</td>
<td>from non-volatile memory within the board</td>
</tr>
<tr>
<td>master</td>
<td>from the master agent</td>
</tr>
</tbody>
</table>
Configuration Views

**Config Changes**
The total number of configuration changes for the board that have been detected since cold/warm start of the agent or since the board was inserted.

**Config Time**
Indicates the time when the last configuration change on the board was detected.

**Baseboard**
Distinguishes the baseboard type from the chassis type.

**Agent Configuration View**

*Access:* From the Icon Subviews menu for the Logical Module icon, select Agent Configuration.

This view contains the following information:

**RAM Version**
The version of the agent in the form “major.minor.maintenance [letters].”

**Local Storage Version**
The version of the agent image saved in local storage such as flash memory in the form “major.minor.maintenance[letters].” If not known or not available, then the value is a zero length string.

**Initial Boot Info Source**
Allows you to choose the initial boot information source. Possible values are other, local, and net using bootp.

**Current Gateway**
The gateway currently in use.

**Next Boot Gateway**
The IP address of the default gateway (router) for the agent to use after the next boot.

**Schedule Boot**
The time at which the device is scheduled to reboot. Reboot can be scheduled up to seven (7) days in advance.

**Cancel Schedule Boot**
Allows cancellation of scheduled boot. Selections are cancel and other.

**Next Boot Image Load Source**
Displays where to get the firmware image for the next time it boots. Possible values are local (stored on the device), net (going out to another computer and getting the image), or other.

**Image Boot Next**
Allows you to select a firmware image type you have downloaded and stored. Possible selections are other, image1, image2, or latest.
**Configuration Views**

**Boot Image 1**
The flashbank which is set to load an image when rebooting, or which image to store when downloading.

**Boot Image 2**
See Boot Image 1.

**Next Boot IP Address**
The IP address of the interface for the next boot.

**Load Server Address**
The IP address of the load server for the configuration file and/or the image file.

**Config File Name**
The name of the configuration file associated with the interface.

**Image File Name**
The name of the firmware image file(s) associated with the interface. Some agents in special situations may support a value which contains multiple file names instead of a single file name. Multiple names are specified as a list of file names separated by semicolons.

**Next Boot Net Mask**
The subnet mask for the interface for the next boot.

**Download**
Allows you to download a new image to the agent. Possible values are other (agent in unknown state), running (agent running after download), and download (re-download a new image).

**Reboot Agent**
Allows you to reboot the agent. Table 14 lists the possible values.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>other</td>
<td>agent in unknown or other state</td>
</tr>
<tr>
<td>running</td>
<td>agent running</td>
</tr>
<tr>
<td>reset</td>
<td>soft reset</td>
</tr>
<tr>
<td>hard reset</td>
<td>hard reset</td>
</tr>
</tbody>
</table>

**Off-Page Reference Panel**
The Off-Page Reference panel in the top-left section of the DevTop view displays icons representing network devices that SPECTRUM “knows” are connected to the SynOptics switch, but for which a specific port connection has not been determined. These triangular-shaped icons must be connected to a port for SPECTRUM to
correctly monitor and manage the connected device.

To connect an Off-Page Reference icon to a port, follow these steps:

1. Select **Edit** from the File menu.
2. Click on the Off-Page Reference icon.
Application Views

This section describes the Application views available for models of SynOptics 28xxx devices in SPECTRUM.

**Access:** From the **Icon Subviews** menu for the Device Icon, select **Application**.

When a device model is created, SPECTRUM automatically creates models for each of the major and minor applications supported by the device. The main Application view identifies all of these application models, shows their current condition status, and provides access to application-specific subviews.

**Figure 7** shows the main Application view in its default mode (Icon) where each of the application models is represented by an Application icon. (See **Figure 8** (Page 27) for a close-up). The Application icons are arranged hierarchically under a Device icon, with major applications in the top row and their respective minor applications stacked directly below.

If you prefer to see applications displayed by name only, in a single, vertical list, select **View > Mode > List**.
Application Icons

When the Application view is in Icon mode, each of the application models is represented by an Application icon. Double-clicking the Model Name Label (a) at the top of the icon opens the associated Model Information view. For some applications, the Model Type label (c) at the bottom of the icon is a double-click zone, which opens an application-specific view. Any views accessible through these double-click zones are also accessible from the Application icon’s Icon Subviews menu.

Supported Applications

The Synoptics 28000 devices support both common applications (those supported by all or most devices) and device-specific applications. Table 15 lists the applications that are commonly available for many or all devices managed by SPECTRUM. Because they are common throughout device management within SPECTRUM, they are described in the documentation listed within the table.

Table 15: Common Applications

<table>
<thead>
<tr>
<th>Application</th>
<th>For more info, see...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing (GenRtrApp) (includes IP Routing)</td>
<td>Routing Applications</td>
</tr>
<tr>
<td>Ethernet (EthernetApp)</td>
<td>Miscellaneous Applications</td>
</tr>
<tr>
<td>Bridging (GenBridgingApp) (includes Static Bridging, Spanning Tree, Transparent)</td>
<td>Bridging Applications</td>
</tr>
<tr>
<td>MIB-II (SNMP2_Agent) (includes ICMP, System2, TCP2, and UDP2 Applications)</td>
<td>MIB-II Applications</td>
</tr>
</tbody>
</table>

Figure 8: Application Icon

- (a) Model Name Label/Model Information View
- (b) Condition Status Label
- (c) Model Type Label/Application-Specific View

SPECTRUM Enterprise Manager
SynOptics 28xxx Common Application

The following submenus, subviews and tables are available through the Syn28CommonApp’s Icon Subviews menu:

- **Agent Information View**
- **Trunk Information View** (Page 34)
- **Switch Community View** (Page 30)

Agent Information View

**Access:** From the **Icon Subviews** menu for the Syn28CommonApp Application icon, select **Agent Information**.

This selection accesses the Agent Configuration and Trap Receiver views, which are described below.

Agent Configuration View

See **Agent Configuration View** (Page 23) for a description of this view.

Trap Receiver View

This view presents trap receiver information in tabular form and allows you to determine which addresses will receive traps generated by the switch.

**Maximum Entries**
Indicates the maximum number of rows in the trap receiver table.

**Current Entries**
The current number of rows in the trap receiver table.

**Next Available Entry**
The index of the next available row to be created in the trap receiver table. A value of zero means that the table is full and no more rows can be added.

**Trap Receiver Table**
Provides a table of trap-receiving managers.

**Receiver**
Indicates a row in the trap receiver table.

**Receiver Status**
Used to create and delete rows in the table.
Table 16 lists and describes the possible statuses.

**Table 16: Receiver Statuses**

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ignore</td>
<td>do not use this entry to send traps to at this time</td>
</tr>
<tr>
<td>delete</td>
<td>deletes the row</td>
</tr>
<tr>
<td>create</td>
<td>creates a new row</td>
</tr>
<tr>
<td>other</td>
<td>some other case</td>
</tr>
<tr>
<td>valid</td>
<td>the row exists and is valid</td>
</tr>
</tbody>
</table>

**Address Type**
The type of address that is stored. The value is “ip” (IP address).

**Network Address**
The network address (in network order) for SNMP manager that is to receive the trap.

**Community String**
Indicates the community string to use.

**Age Time**
The time interval used to age entries out of the trap receiver table. The default value if not specified will be 0, or infinite, never to be aged out.

This button opens the Add Trap Receiver View, described below.

**Add Trap Receiver View**
This view contains the following information:

**Next Entry Index**
The value of the next index in the table.

**Use Entry Index**
The entry currently in use.

**Network Address**
The address of the station to which you want traps to be sent.

**Address Type**
The address type.

**Community Name**
The community name.

**Status**
The status of the trap received.

**Age Time**
The time the trap was received.
Switch Community View

Access: From the Icon Subviews menu for the Syn28CommonApp Application icon, select Switch Community.

This selection contains a submenu: Domain, Trunk Information, Switch List, and History Logs.

Domain

Access: From the Icon Subviews menu for the Syn28CommonApp Application icon, select Switch Community > Domain.

This view contains the following fields and the Domain Table:

Switch Type
The type of switch: Master or Normal.

Operating Mode
Allows choice of operating mode. Possible selections are basic (default Operation Mode (no user domains)), virtual (port has been configured in a user domain), or other.

Number of Domains
Displays the number of domains in the network.

Number of Ports in Domains
Displays the number of ports in all the domains.

Domain Table
The Domain Table identifies the domains in the switch community. Only those domains that are related to the switch can be seen when communicating to a non-master switch. Only the master switch has the entire domain information for a switch community.

This table contains the following fields and buttons:

Domain Id
The unique ID of the domain.

Domain Name
The name of the domain.
Application Views

Status
Allows you to create and delete rows in the table. Table 17 lists and describes the possible statuses.

Table 17: Domain Statuses

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>create</td>
<td>creates a new row</td>
</tr>
<tr>
<td>delete</td>
<td>Deletes an existing row. A domain cannot be deleted until there are no ports configured as part of that domain. You must delete all ports participating in this domain from the lsDomPortTable before deleting this row.</td>
</tr>
<tr>
<td>active</td>
<td>row exists</td>
</tr>
</tbody>
</table>

Ports
The current number of ports configured as being part of the domain. The value zero indicates that the domain exists, but has no ports configured.

Age Time
The time interval (in units of 10 minutes) used to age out all MAC addresses within this domain from the Port to MAC mapping table. The default value is 24 (240 minutes).

Configuration Changes
The total number of configuration changes to this domain such as adding a port or removing a port, since warm/cold restart or the previous topology change.

Prev ID
The ID of the domain before domain ID collision occurs. The domain ID collision occurs upon merging switch communities with same domain ID which was created by different domain management entities. The collided domain ID will be reassigned to guarantee the uniqueness of domain ID throughout the switch community.

Domain Configuration
Highlight a line in the Domain view and click this button to access the SynOptics 28xxx Domain Configuration View, which contains the following information.

Domain ID
The unique ID of the domain.

Domain Name
The name of the domain.

Domain Status
Allows you to create and delete rows in the table. Possible values are create (create a new row),
delete (deletes an existing row), or active (row exists). A domain cannot be deleted until there are no ports configured as part of that domain. You must delete all ports participating in this domain from the IsDomPortTable before deleting this row.

**Number of Ports**
The current number of ports configured as being part of the domain. The value zero indicates that the domain exists, but has no ports configured in it.

**MAC Age Time**
The time interval used to age out all MAC addresses within this domain from the Port to MAC mapping table. The default value is 300.

A value of zero means the table never aged out entries.

**Total Changes**
The total number of configuration changes to this domain such as adding port or removing port, since warm/cold restart or the previous topology change.

**System Up Time**
The amount of time the system has been running.

**Previous Domain ID**
The ID number of the previously domain configuration.

**Domain Port Table**
The Domain Port Table contains the following information:

- **Domain ID**
The ID of the domain containing the port.
- **Switch ID**
The unique identifier for the switch containing the port.
Application Views

Slot
The slot number on the switch identifying the port.

Port
The port number on the switch.

Create Domain
Opens the Domain Creation View, described below.

Domain Creation View
This view contains the following information:

Next Available ID
The number for the next domain which is then entered in the Next ID field below it.

Enter Next ID
The number of the Domain received from the Next Available ID field above it.

Domain Status
Allows you to create and delete rows in the table. Possible values are create (create a new row), delete (deletes an existing row), or active (row exists).

A domain cannot be deleted until there are no ports configured as part of that domain. You must delete all ports participating in this domain from the lsDomPortTable before deleting this row.

Domain Name
The name of the domain.

MAC Age Time
The time interval used to age out all MAC addresses within this domain from the Port to MAC mapping table.

The value of zero means to never age out entries. The default value is 300.

Open the Domain Creation View.

Port Domain
Opens the Port Domain View. This view is used to assign a port to a different domain. This view contains the Port Domain Table which provides the following information:

Port Domain Table
The Port Domain Table identifies the domain in which every port on each switch in a switch community is configured.

Only those Domain-Ports information within a switch can be retrieved when communicating to a non-master switch.
Application Views

An entire Domain-Ports information within a switch community can be retrieved through the master switch only.

**Switch ID**
The unique identifier for the switch containing the port.

**Slot**
The slot number on the switch identifying the port.

**Port**
The port number on the switch.

**Domain ID**
The ID of the domain containing the port.

### Standard Table Buttons

The Switch Community view contains the following standard table buttons. You can reorganize tables accessed through this view by using the buttons located either at the top or at the bottom of the table. These buttons will be displayed after you click a column heading.

- **Sort**
  Allows you to sort the table based on the column heading you select. To use the Sort feature, select a column heading and click the **Sort** button. The table is rearranged according to the chosen column.

- **Find**
  Allows you to search the table for a specific entry. To use the Find feature, select a column heading, click the **Find** button, and enter a search string in the dialog box. The Find feature does not accept partial strings. Not all column headings will present the **Find** button.

- **Table**
  Updates the table information.

### Trunk Information View

**Access:** From the **Icon Subviews** menu of the Syn28CommonApp Application icon, select **Community Switch > Trunk Information**.

**Switch Type**
The switch type.

**Time of Last Change**
The time of the last change.

**Number of Changes**
The total number of changes made.

**Number of Rows**
The total number of rows
**Application Views**

**Trunk Information Table**
This table contains the following information:

**LsId From**
Indicates the switch which is the source of the ‘root’ trunk interconnection.

**Slot From**
The slot number in the source switch containing the ‘root’ trunk interconnection.

**Port From**
The port number in the source switch used for the ‘root’ trunk interconnection.

**LsId To**
The switch which is the destination of the ‘root’ trunk interconnection.

**Slot To**
The slot number in the destination switch containing the ‘root’ trunk interconnection.

**Port To**
The port number in the destination switch used for the ‘root’ trunk interconnection.

**State**
Indicates the state of a trunk between two switches. The trunk state is determined by the internal topology algorithm, automatically. The values are **active** (the trunk is active and passes both user and management data) or **standby** (the trunk is inactive and does not pass user data: only management data is passed through this trunk).

**Switch List View**

**Access:** From the **Icon Subviews** menu for the Syn28CommonApp Application icon, select **Switch Community > Switch List.**

**Switch Type**
The type of SynOptics 28xxx switch.

**Number of Switches in LAN**
The number of switches contained in your LAN.

**Switch List Table**
The Switch List Table contains the following switch identification for all switches in a switch community:

**Switch ID**
The unique switch identifier.

**Vendor**
The vendor name of the switch manufacturer.

**Switch IP**
The switch IP address.
Switch Type
The switch type. The master switch is elected by the internal topology algorithm. There is one and only one master switch within a switch community. The values are “normalSwitch” (not a master switch) and “masterSwitch”.

History Logs
Access: From the Icon Subviews of the Syn28CommonApp Application icon, select History Logs.
This selection contains a subview menu: Reset History, Error History, and Trace History, all of which are described below.

Reset History
Access: From the Icon Subviews menu for the Syn28CommonApp Application icon, select History Logs > Reset History.
This view contains the following information:

MaxEntries
The maximum number of reset history rows that can exist within a switch.

Entry
Each entry in the reset history table contains date, time and reason for each reset. Rows can not be created or deleted via SNMP.

Index
The index number of a reset history entry.

Date
The date when the reset occurred for this switch.

Time
The time when the reset occurred for this switch.

Reason
Indicates the reason for the system resetting.
Table 18 lists and describes the possible reasons.

Table 18: Reasons for System Reset

<table>
<thead>
<tr>
<th>Reason</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>power</td>
<td>power up reset</td>
</tr>
<tr>
<td>hwReset</td>
<td>reset through reset button</td>
</tr>
<tr>
<td>swReset</td>
<td>software reset</td>
</tr>
<tr>
<td>wdtReset</td>
<td>watch dog timeout reset</td>
</tr>
<tr>
<td>busErrReset</td>
<td>bus error reset</td>
</tr>
<tr>
<td>sysReset</td>
<td>other exception error reset</td>
</tr>
</tbody>
</table>

Error History
Access: From the Icon Subviews menu for the Syn28CommonApp Application icon, select History Logs > Error History.
Application Views

This view contains the Error Log Table, described below.

Error Log Table
The Error Log Table lists the error history log for a switch. This table provides the following information:

MaxEntries
The maximum number of error history log rows that can exist for a switch.

Entry
A row in the error log table which enumerates the switch id, date, time and description for the error. Rows can not be created or deleted via SNMP.

Index
The index number of a error log entry.

Date
The date when the error occurred in this switch.

Time
The time when the error occurred in this switch. The time of the lost polling cycle.

Reason
The type of error that occurred in the switch. Table 19 lists the possible error types:

Table 19: Reasons for Errors Within Switches

<table>
<thead>
<tr>
<th>Reason</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fanFail</td>
<td>fan failure</td>
</tr>
<tr>
<td>noMemory</td>
<td>insufficient memory</td>
</tr>
<tr>
<td>imageLoadFail</td>
<td>image downloading failed</td>
</tr>
<tr>
<td>macTableFull</td>
<td>Mac address table is full</td>
</tr>
<tr>
<td>noCpuBuffer</td>
<td>CPU driver has insufficient buffer space</td>
</tr>
</tbody>
</table>

Trace History
This view contains the Trace Log Table, described below.

Trace Log Table
This table contains the following information:

Current
The current number of rows in the trace log table.

Last Event
Provides a description of the last event that generated a debug trap.
Table
Lists the event trace log for a switch.

Entry
Displays a row in the event trace log table which enumerates a subsystem id, an event code, an event count, date and time, an option, and a description of the event. Rows cannot be created or deleted via SNMP.

Index
The index number of an event log entry.

Description of Event
Provides a description of the event.

Sy28xEnSwchApp
The following application-specific subviews are available from this application:

- Port Configurations Table (Page 15)
- Port to MAC View (Page 38)

Port Configurations Table

Access: From the Icon Subviews menu for the Sy28xEnSwchApp Application icon, select Port Configurations.

This subviews menu selection opens the SynOptics 28xxx Port Configurations View. See Port Configurations Table (Page 15) for a description of this view.

Port to MAC View

Access: From the Icon Subviews for the Sy28xEnSwchApp Application icon, select Port to MAC.

This view contains the Port to MAC Table that identifies all the MAC addresses seen on each feeder and trunk port.

The following information is shown for each port:

- Slot
  The slot number of the switch containing the port.

- Port
  The port number on the switch.

- MAC Address
  The MAC address seen on the port.
Model Information Views

This section provides a brief description of the Model Information views available for models of SynOptics devices in SPECTRUM.

Model Information views provide descriptive and configuration information about SPECTRUM models of individual devices, interfaces, and applications. Figure 9 shows an example of the Model Information view accessed from the Subviews menu for the model’s Device icon. Model Information views are also available for each of the Interface icons in the Interface Device and Interface Device Topology views, and for each of the Application icons in the Application view. Although these views may vary slightly depending on the particular entity being modeled, their basic layout and content are similar for most SPECTRUM management modules. Therefore these views are described in more detail in SPECTRUM Views.

Figure 9: Model Information View

---

SPECTRUM Enterprise Manager  Page 39  SynOptics 28xxx
Index

A
Add Trap Receiver View 29
Agent Configuration View 23, 28
Agent Information 28
Align Errors 12
Application
  Bridging (GenBridgingApp) 27
  Ethernet (EthernetApp) 27
  MIB-II (SNMP2_Agent) 27
  Routing (GenRtrApp) 27
Application View 26

B
Boot Image 1 24
Boot Image 2 24
Buffer Overflows 13

C
Chassis Configuration View 21
Chassis Contact 21
Chassis Description 21
Chassis Location 21
Chassis Serial Number 21
Chassis Switch ID 21
Chassis Type 21
Chassis Version 21
Common Applications 26
Configuration View 15
Congestion 13
Connecting Device 18
Connector 16
Crc Errors 12
Dynamic Representation 8
Enable/Disable Port 13
Error History 36

F
Find
  Button 34
Flow Control 19
Frames 13

G
Good Frames 12
History Logs 36

H
History Logs 36

I
Internal Received 13
Internal Transmit 12
Internal-to-Network Statistics 13
Edit 25
L
Last Configuration Changes 21
Link Status 16
Link Type 17
Local Storage Version 23
Logical Device View 8
Logical Representation 8
Lsld From 35
Lsld To 35

M
Media Type 16
Module
 Identifier 9
 Number 9
Module Status 9

N
Network Received 12
Network Transmit 13
Network-to-Internal Statistics 12
Next Boot Gateway 23
Next Boot Image Load Source 23
Next Boot Type 19

O
Off-Page Reference Panel 24
Operational Type 18
Overruns 12

P
Partition Status 16, 19
Physical Device View 14
Port
 Identifier 9
 Status 9
Port Configurations Table 15
Port Reset 21
Port Speed 10
Port Statistics 12
Port to MAC View 38
Port Type 10
Port Type Configuration 19

R
RAM Version 23
Receiver 28
Receiver Status 28
Remote Fault 18
Reset History 36
Restricted Rights Notice 2

S
Slot 16
Sort Button 34
SPECTRUM Support 6
SPMA
 And the Token Ring MicroLAN
 Switch Module 6
Static 8
Status Display 22
Switch Community 30
Switch Community View 11
Switch IP 35
Switch List View 35
Sy28xEnSwchApp 38
Syn28CommonApp 28

T
Table Buttons 34
Topology Mode 22
Total Configuration Changes 21
Trace History 37
Trademarks 2
Trap Receiver Table 28
Trap Receiver View 28
Trunk Information View 34